CHAPTER 2

Main concepts of ILWIS 3.0

In chapter one, Introduction to ILWIS, you started with ILWIS, and learned the basics of the user interface. This chapter presents some key concepts of ILWIS.

In section 2.1, the two basic data models (vector and raster models) that are used in ILWIS are treated together with the different types of objects (i.e. data objects, service objects, container objects and special objects). In section 2.2 the various types of maps are shown: point, segment, polygon and raster maps. Vector and raster maps can be displayed simultaneously in a map window. In this section and in section 2.3 you will also have a closer look at one of the key concepts of ILWIS: the use of domains. A domain lists e.g. the possible units in a map (as class names or IDs) or the range of possible values in a map. A representation, treated in detail in section 2.4, contains the information that determines how your spatial data should be represented on screen or in a printout. A coordinate system (section 2.5) contains information on the kind of coordinates you are using in your maps. In section 2.6 of this chapter you will pay special attention to the georeference (containing information about the number of lines and columns of a raster map, the coordinates and the pixel size). In the sections 2.7 and 2.8 you will see how spatial and attribute data are linked and how you can retrieve information from both simultaneously, by using the pixel information window. In section 2.9 the details view of the Catalog is treated. The last section, section 2.10, deals with another important concept of ILWIS: dependency links. In ILWIS the maps, tables and columns created by an operation, know how they were made. This has some major advantages, such as the possibility to store only the definition of a map, without storing the data of the map itself, and the possibility to simply recalculate output maps when input data has been changed (make output maps up-to-date).

Before you can start with the exercises, you should start up ILWIS and change to the subdirectory C:\ILWIS 3.0 Data\Users Guide\Chapter02, where the data files for this chapter are stored.

- Double-click the ILWIS icon on the desktop.
- Use the Navigator to go to the directory: C:\ILWIS 3.0 Data\Users Guide\Chapter02.
2.1 Structure of spatial data in ILWIS

In the previous chapter we have looked at how you can display maps and tables in ILWIS. Now we will see more in depth how the data are structured. We will treat the structure of spatial data.

Spatial features are represented in ILWIS in the following ways:
- Points. Many items can be represented as single points on a map. Points may refer to rainfall stations, houses, field observations, sampling points, etc.
- Lines. Linear features such as roads, drainage lines or contour lines.
- Areas. Features which occupy a certain area, such as land use units (e.g. forest), geological units, etc.

The spatial entities described above can be represented in digital form in two data models (Figure 2.1): vector models or raster models. Both models store details on the location of entities and their value, class name or identifier. The main difference between the two data models is the way they store and represent the locations.

**Vector model**

In a vector model the position of each spatial feature is defined by (a series of) X and Y coordinates. Besides the location, the meaning of the feature is given by a code (label).

**Points**

The location of a point is described by a single XY coordinate pair. Points are stored
in point maps by registering their location in X and Y coordinates and by coding them (e.g. a rainfall station, elevation, etc.).

Segments

A line is stored as a series of X and Y coordinates (points) that best reflect its characteristics. The points are connected by straight lines. In ILWIS line features are called segments. A segment is described by the coordinates of its starting and ending points (its nodes) and the intermediate points. The code of a segment defines what the segment represents (e.g. road, state boundary, contour value, etc.).

Polygons

Areas are represented by their borders or boundary lines, which are in fact lines stored in the same way as segments. A polygon is a closed area of one or more boundary ‘segments’ and a code. Boundary segments define both the boundary of the polygon to their left as to their right (topological structure). An area defined by its boundary line and by its code is called a polygon. The code of a polygon defines the contents of the polygon (e.g. forest, city, sandstone, etc.).

In ILWIS vector maps are either point, segment, or polygon maps. Most of these maps are obtained by digitizing or by importing them. Vector maps require less disk storage space and are suitable for creating high quality outputs. They are less suitable for a number of GIS operations, especially those dealing with map overlaying. You can rasterize the vector maps into raster maps (this will be explained in chapter 4). In ILWIS, most of the analysis operations are raster-based.

Raster model

In a raster model, spatial data are organized in grid cells or pixels. Pixels, a term derived from picture element, are the basic units for which information is explicitly recorded. Each pixel is only assigned one value. The maps stored in ILWIS according to the raster model are called raster maps. Pixels in a raster map all have the same dimensions. Thus, it is not necessary to store all pixel coordinates as the pixels are arranged in a regular pattern. It is enough to determine the pixel size and the parameters to transform between X and Y coordinates of a map and the pixel locations in the raster map (rows/lines and columns). The process to establish this relationship is called georeferencing. Through a georeference you thus know the relationship between a coordinate system and pixel locations in the image.

A point is described in the raster model by the position of a single pixel. The position of each cell is defined by a row and column number. A pixel is assigned a code (label). A line and an area are described by a set of connected pixels having the same code (label). In the raster model there is no basic difference in how points, lines and areas are stored.

Through rasterization vector data (points, segments or polygons) can be converted to the raster format. Apart from this source of raster maps, there are imported images, either satellite images, scanned aerial photographs or imported raster maps from other sources. Most ILWIS analyses are based on the raster data model. The results of most of the operations are also raster maps.
Object types

Before we are going to display vector and raster maps and investigate the different types of domains, it is may be useful to explain that ILWIS uses different types of objects.

- **Data objects.** Raster maps, polygon maps, segment maps, point maps, tables and columns are called data objects. They contain the actual data.
- **Service objects.** Service objects are used by data objects; they contain accessories that data objects need besides the data itself. Domains, representations, coordinate systems and georeferences are called service objects.
- **Container objects.** Container objects are collections of data objects and/or annotation: map lists, object collections, map views, layouts and annotation text.
- **Special objects.** Special objects are histograms, sample sets, two-dimensional tables, matrices, filters, user-defined functions and scripts.

A vector map needs a coordinate system, a domain and a representation. These service objects are also needed for raster maps, together with another type of service object: a georeference. In this chapter we will focus our view on data and service objects. The container and special objects will be treated in other parts of the ILWIS User's Guide.

**Summary: Structure of spatial data in ILWIS**

In this section you learned the following:

- ILWIS uses two types of maps: vector maps and raster maps.

- Vector maps in ILWIS are either point maps, segment maps or polygon maps.

- Vector maps can be obtained either by digitizing analog maps, or by importing them from other sources.

- Raster maps can be obtained either by rasterizing vector maps, by importing them from other sources or by performing GIS or image processing operations in ILWIS.

- Raster maps, polygon maps, segment maps, point maps, tables and columns are called data objects. They contain the actual data.

- Service objects are used by data objects; they contain accessories that data objects need besides the data itself. Domains, representations, coordinate systems and georeferences are called service objects.

- Vector maps need a number of service objects: a domain, a representation and a coordinate system.

- Raster maps also need these service objects: a domain, a representation and a coordinate system. All raster maps contain information in discrete cells or pixels, which are ordered in rows and columns. To relate these pixels to map coordinates another service object called a georeference is needed.
2.2 Displaying maps and Layer Management

Displaying vector and raster maps

Let us now have a look at the different types of maps in ILWIS. In chapter 1 you have seen the Landuse map. Remember that it was a polygon map. Let us now compare the polygon map with a raster map, which is obtained by rasterizing the polygon map.

- Double-click polygon map Landuse in the Catalog. The Display Options - Polygon Map dialog box is opened.
- Accept the defaults in the Display Options - Polygon Map dialog box by clicking OK. The polygon map is displayed.
- Click the Title bar of the map window, keep the left mouse button down, and move the map window to the side of the screen. Then release the left mouse button. This is called dragging.
- Double-click raster map Landuse in the Catalog. The Display Options - Raster Map dialog box is shown in which you can specify how you want to see the raster map. Note that there are less options than in the Display Options - Polygon Map dialog box.
- Accept the default values in the dialog box by clicking OK. The raster map is displayed in another map window.
- Drag and successively resize both windows so that they are next to each other.

The first impression is that both maps are the same. They are similar with respect to the information they contain. You can check this by clicking the same unit in both maps. The units of both maps are also displayed in the same colors. The difference, however, is in the way the information is stored in both maps; one in vector format and the other in raster format. The best way to evaluate this is by zooming in on both maps.

- Click the Zoom In button in the Toolbar of the raster map. Position the mouse pointer in a section of the map near the boundary of several units. Press the left mouse button, hold it down, and drag it to define a small area to zoom in on.
- Repeat this procedure for the polygon map. Zoom in on the same area.

Now you can see quite some differences between the two maps. The polygon map displays smooth boundaries between the units, whereas the raster map has a blocky appearance. If this is not clear then zoom in further. The blocky appearance of the raster map is due to the regular arrangement of the pixels. You are able to see individual pixels and the land use unit they represent.
We can see the individual pixels even more clearly when we display another type of raster map: a satellite image (Tmb1: Band 1 of a Landsat Thematic Mapper image).

Now the raster map Landuse in the map window is substituted by the raster map Tmb1. It is only possible to display one raster map in a map window at the same time, since you cannot see two colors of two pixels on top of each other.

In a satellite image nearly each of the individual pixels has a different value than its neighbours, due to the different reflectance values of the earth surface as recorded by the sensor of the satellite. To read some of the pixel values:

The values that you can read from the map are whole numbers between 0 and 255. This means that whenever we work with satellite images (such as SPOT or Landsat) the domain of these images is called image. Domain image is used for satellite images, and scanned black and white aerial photographs. Pixel values in a band of a satellite image represent reflection values in a certain wavelength interval.
Layer management

- In the Catalog of the Main window select satellite image Tmb1 and drag it to the map window containing polygon map Landuse. The Display Options - Raster Map dialog box is opened.
- Accept the defaults and click OK. Raster map Tmb1 is now added to the map window.

In the map window, polygon map Landuse is displayed on top of raster map Tmb1. A map window can contain only one raster map, but it can be combined with several segment, polygon or point maps. Each of the maps displayed in a map window is called a data layer.

- In the Layer Management pane, drag and drop the Landuse data layer below the Tmb1 data layer. Now raster map Tmb1 is displayed on top of polygon map Landuse.
- Move with the mouse pointer through the map while keeping the left mouse button pressed. The values that can be read from the map are the values of raster map Tmb1.
- Double-click Tmb1 in the Layer Management pane. The Display Options - Raster Map dialog box of raster map Tmb1 appears.
- In the Display Options - Raster Map dialog box clear the Info check box. This means that you will not see the values of the pixels anymore when clicking in the map.
- Accept all other defaults and click OK. Note that in the Layer Management pane the i in front of the Tmb1 check box has disappeared.
- Move again with the mouse pointer through the map while keeping the left mouse button pressed. The classes that can be read from the map viewer are the class names of polygon map Landuse.
- In the Layer Management pane, select polygon map Landuse. Press the right mouse button and choose the Remove Layer command or click the Remove Layer button in the Toolbar of the map window. The Remove Layer box appears with the question Remove Polygon Map “Landuse” Are you sure?
- Answer this question with Yes.

Let us now look at another polygon map. We have already seen the polygon map Landuse, which has a class domain. We will now look at the polygon map Cityblock, which contains the city blocks of a part of the city of Cochabamba.

- Open the Layers menu and select the Add Layer command or click the Add Layer button in the Toolbar of the map window. The Add Data Layer dialog box is opened.
You will see that each city block is identified by a number. These numbers, however, do not represent measured, calculated, or interpolated values. Each city block has its own code and information from each individual block can be obtained from a table connected to the map. The polygon map Cityblock has an identifier domain (ID domain).

Until now you saw two polygon maps (Landuse and Cityblock) and two raster maps (Landuse which was obtained by rasterizing the polygon map Landuse and a satellite image Tmb1).

Now we will have a look at the other types of vector data: segment maps and point maps.

You will see that each city block is identified by a number. These numbers, however, do not represent measured, calculated, or interpolated values. Each city block has its own code and information from each individual block can be obtained from a table connected to the map. The polygon map Cityblock has an identifier domain (ID domain).

Until now you saw two polygon maps (Landuse and Cityblock) and two raster maps (Landuse which was obtained by rasterizing the polygon map Landuse and a satellite image Tmb1).

Now we will have a look at the other types of vector data: segment maps and point maps.

You will see that each city block is identified by a number. These numbers, however, do not represent measured, calculated, or interpolated values. Each city block has its own code and information from each individual block can be obtained from a table connected to the map. The polygon map Cityblock has an identifier domain (ID domain).

Until now you saw two polygon maps (Landuse and Cityblock) and two raster maps (Landuse which was obtained by rasterizing the polygon map Landuse and a satellite image Tmb1).

Now we will have a look at the other types of vector data: segment maps and point maps.
The contents of segment map Contour are different from segment map Drainage. The contour lines are all coded according to their elevation. In this case the contents cannot be represented as classes, but as values. The map Contour therefore has a value domain.

Finally, let us have a look at a point map. The point map that will be displayed shows the location of rainfall stations in the area (it is a fictive map, only meant for this User's Guide and not representing the real situation in Cochabamba).

Please note that point map Rainfall also uses an ID domain. The domain of a map is always indicated at the top of a Display Options dialog box. In the dialog box there is an option to show the names of the points as well.

Note that the names of some of the rainfall stations are only partially shown, because those stations are situated just outside the area covered by the satellite image.
Summary: Displaying maps and Layer Management

In this exercise you learnt the following:
- ILWIS allows the display of many data layers in the same map window. A map window can display only one raster map, but a raster map may be displayed together with many different point, segment and/or polygon maps.

- The way in which various data layers are displayed in a map window can be manipulated via the Layer Management pane.

- In the Layer Management pane you can select the layers to be displayed, and from which layers you want to obtain information. You can change the display options of a layer, the order of the layers and you can add or remove layers.
2.3 About domains

In the previous section you have already seen the four most important types of domains:
- **Class** domains for data objects that contain classes (e.g. land use units, geomorphological units);
- **ID** domains for data objects that contain unique identifiers (e.g. city block 102, rainfall station Laguna);
- **Value** domains for data objects that contain measured, calculated or interpolated values (e.g. height, concentration);
- The **Image** domain for satellite images or scanned aerial photographs containing values between 0 and 255.

A domain stores the set of possible data ‘values’ (class names, IDs or values) that should be available in a map, table or column.

ILWIS uses domains extensively and for many operations you should decide in advance about the domain of a resulting map: a class map, an ID map, or a value map. This enables you to have a direct control over your data types, e.g. having the domain as a separate object you can have a direct look at the kind of data are stored in your maps.

In several other raster-based GIS systems, and also in the previous DOS versions of ILWIS, you always had to remember what each pixel represented. For example, if you had a land use map with 4 classes (in which 1 = Agriculture, 2 = Forest, 3 = Grassland and 4 = Shrubs) and when you wanted to find the areas which are suitable for further development (e.g. the current shrub area). Then, to show the suitable areas you had to use a map calculation formula (this will be explained in depth in chapters 7 and 8) which had the following form:

\[ \text{Result} = \text{IFF(Landuse}=4, 1, 0) \]

This formula meant: if the Landuse map has a pixel value of 4 (shrubs), then the resulting map will have a value of 1 (meaning that it may be used for further development), and otherwise a value of 0 (not suitable).

From ILWIS 2 onward, you use domains and you no longer need to know the relation between the pixel values and the classes, since ILWIS keeps track of that. In ILWIS, your map calculation formula reads:

\[ \text{Result} = \text{IFF(Landuse}="\text{Forest}", "\text{Suitable}", "\text{Not suitable}"\) \]

The resulting map is also a class map, so you directly know what the units mean.

Let us look now at some other advantages of domains.

More about class domains

Class A class domain consists of a list of class names and optionally class codes. Elements in a map (points, segments, polygons or pixels) which uses a certain class domain, are coded by the class names and codes present in that class domain; elements
without a class name are considered undefined. The same class name can be used for several points, segments, polygons or mapping units in one map. As you will remember from the previous exercise, polygon map Landuse had a class domain, which contained the names of the different land use types.

- Open the domain of polygon map Landuse by double-clicking the domain Landuse in the Catalog. The Domain Class editor is opened.

The Domain Class editor allows you to add new items to the domain, and to change or delete existing ones. One should be careful, however, with deleting domain items, since this may cause problems in the maps and tables that use this domain. For example, if you delete the Forest item, there will be polygons in the map Landuse with an internal code that is not present anymore in the domain. The forest unit in the map will then be represented as undefined (?) and will also loose its color. You should always take care that a domain contains all the items that can occur in a map or a table.

A domain may contain more items, however, than are present in the map. This is very useful if you have different maps dealing with the same topic, for example multi-temporal land use maps of a certain area, or various geological maps with the same legend.

What is the advantage of the domain approach? Let us give an example:

- Suppose you have two land use maps of different regions in the same country.
- Suppose in one map you have land use types agriculture, grassland and shrubs, and in the other map agriculture, forest and shrubs. In the DOS versions of ILWIS, pixel values of your units might be Agriculture = 1, Grassland = 2 and Shrubs = 3 for the first map, and Agriculture = 1, Forest = 2 and Shrubs = 3 in the second map. So, pixel value 2 is once forest and once grassland, which is very confusing!

However, if you use one domain containing all the possible land use classes, you do not need to care about pixel values of separate maps since all the necessary information for all your land use maps is stored in one domain. The domain then contains the class names: Agriculture, Forest, Grassland, Shrubs.

- Open the File menu in the Domain Class editor, and select the Properties command or click the Properties button in the Toolbar of the editor. The Properties of Domain Class “Landuse” sheet appears, which describes among others what this domain is used for.
- Click the Used By tab.

You see a list of objects that are using this domain Landuse: raster map Landuse, polygon map Landuse, table Landuse, and representation Landuse.
This is the domain of the geomorphologic map. The list of classes in this domain looks a bit different to the one of the land use classes. You see first a Class Name and then a Code. Since some of the class names can be very long, ILWIS allows the use of abbreviations, or codes for the domain items. This is very handy when you want to do calculations with maps, or columns. Instead of having to write a expression like:

```
Result = IFF(Geomorphology="Accumulation of debris on slope", "Possible landslide", "Not a possible landslide")
```

You can now write:

```
Result = IFF(Geomorphology="Ad", "Possible landslide", "Not a possible landslide")
```

Codes can be entered, edited and deleted with the Add Item, Edit Item and Delete Item commands on the Edit menu, with the buttons in the Toolbar of the Domain Class editor or by using the right mouse menu on a domain item.

More about identifier domains

An identifier domain can be used when each element in a map is identified by a unique name, i.e. an identifier (ID); elements without an identifier are considered undefined. Each item occurs in principle only once in the map. Attributes can be linked to the unique names, that is to the identifiers. The attribute table contains additional information on the uniquely identified elements and uses the same domain as the map. An identifier domain can be used in point, segment, and polygon maps, and in rasterized point, segment, and polygon maps. The identifier domain is advised for detailed maps on large scales such as 1:500 for cadastral and infrastructural purposes.

Let us now look in more detail at some identifier domains.

```
• In the Catalog, click domain Cityblock with the right mouse button and select Open from the context-sensitive menu.
```

Domain Cityblock is an identifier (ID) domain. It is linked to the polygon map with the city blocks, as well as to the table Cityblock. Domain Cityblock contains the cadastral codes of the city blocks of the central part of Cochabamba city.
In this case the identifiers are *unique numbers*.

- Close domain Cityblock, and open domain Rainfall.

Domain Rainfall is also an ID domain (you can check this for instance by opening the Properties of the domain). In this domain, the individual items are the *unique names* of the rainfall stations. It is not a class domain, since each name is only valid for one rainfall station only. If it would be related to more rainfall stations, the system would not know to which station the data in the corresponding table Rainfall are referring.

- Close the Domain Identifier editor.

**More about value domains**

Value maps and value columns use a value domain. Elements in value maps (raster, polygon, segment, or points) or fields in value columns represent measured, calculated, or interpolated values. Values in a value domain are defined by a minimum and maximum value (the value range) and a precision; values smaller than the minimum or larger than the maximum are considered undefined.

In this section we will look at some value domains.

- Open the domain 🏆 Height.

Domain Height is used for segment map Contour which contains contour lines. A value domain looks quite different from a class or ID domain. It is not a list of names or codes, but it is a definition of certain values that should be used in a map or a column. In this example, domain Height describes the Height in meters.

For the Cochabamba area, height values range from 2500 to 4600 meters. These are the minimum (Min) and maximum (Max) values of the domain Height.

The Precision of a value domain determines the increment between two possible successive values. The precision determines for instance the number of decimals that are used to store the values. When you use a precision of 0.1 the values are stored with 1 decimal. You can also store values with a certain step size, for example only the values ending on 5, 10, 15, 20, 25, etc. In that case you use a precision of 5. You can use any value for the precision, as long as it makes sense with respect to the minimum and maximum value, and the meaning of the values. For instance, it would be quite useless to use a precision of 0.001 for the domain Height, since the altitude of the contour lines are in meters on the topographic map from which they were digitized.

It is important to keep in mind, that if you use very small values for the precision (for
example 0.0000001), the size of the map on disk can become very large (up to 8 bytes per pixel). This will also lead to slower performance of the system and to disk space problems. So you should use a precision which is useful for the data you are working with.

Domain Height is a so-called *user-defined value domain*. It was created for the demo data set. User-defined value domains are useful when you have a series of maps for which you need the same range of values and the same precision. You do not have to define a new domain for each map, and even more important, you can show these maps with the same representation. User-defined value domains can have their own representation value. For example, when you are working with digitized contour maps of different areas and when all maps should by default be displayed in the same colors.

- Close the Height domain.

There are also a number of *system-defined value domains*. These value domains are defined by the system and are stored in the ILWIS\System directory. System-defined value domains can be displayed in the Catalog but it is not possible to change them.

- In the Main window open the View menu and select the Customize Catalog command or click the Customize Catalog button in the Standard toolbar. The Customize Catalog sheet appears.
- On the Selection tab, select object type Domain in the list box and click Apply. Now you will see only the user-defined domains in the Catalog. These domains have been made especially for the data set.
- On the Selection tab, select the check box Include System Objects and click OK. Now also the system-defined domains are listed in the Catalog.

The most important system-defined value domain is the one called Value. In fact you can make all other value domains with this domain. The others are given to prevent you from needing to define domains too often. Let us look at some examples.

- Open the system domain Value. As you can see, the minimum value that can be stored is -9999999.9 and the maximum is the positive equivalent of that. So it is safe to conclude that you can store all possible values which may occur in maps and tables in the value domain.
- Close domain Value and open domain Perc. This is a special value domain which is intended for storing percentage values with a default value range between 0 and 100, and a precision of 0.01 (two decimals).
- Close domain Perc and open the Bool domain. This is the Boolean domain, which only allows two situations: False (0) or True (1). Like most other
value domains also undefined values can be used in the Bool domain. In maps and columns, undefined values are represented by a question mark (?)..

- Have a look at some other system value domains. When you have finished, select all object types again via the Customize Catalog sheet and clear the check box Include System Objects.

There are some domain types that we have not yet treated so far, because they are specific for certain operations. They will be discussed later on in this book. A complete overview of domains can be obtained from the ILWIS Help topic “ILWIS Objects, Domains”.

Summary: About domains

- A domain stores the set of possible data ‘values’ that are used by a map, table and/or column. All ILWIS data objects (vector maps, raster maps and tables) always have a domain.

- The same domain can be used by a vector map, a raster map and a table.

- The four most important types of domains are: class domains, identifier domains, value domains and the image domain.

- Class domains are used for data objects that contain classes. A class domain may for instance store the names of land use units or geomorphological units.

- ID domains are used for data objects that contain unique identifiers. An ID domain may for instance store the unique IDs of city blocks, or the unique IDs of rainfall stations.

- Value domains are used for data objects that contain measured, calculated or interpolated values. A value domain may for instance store the values (range and precision) needed to define heights or to define concentrations.

- The system Image domain is used for satellite images or scanned aerial photographs containing values between 0 and 255. This domain is a special type of value domain, as the image domain cannot contain undefined values.

- Class and ID domains are always user-defined. Value domains can be user-defined, or system-defined.
2.4 About representations

A representation contains the information that determines how your spatial data should be represented on screen or in a printout. Representations are service objects linked to a domain. The domain determines what is in a map (or a table or a column), and the representation defines the colors of the domain items. There are different types of representations depending on the type of domain.

More about representation class

Class domains have the most straightforward representation. A map with a class domain should have a representation, otherwise it is impossible for ILWIS to know how to display it. A representation for a class domain is always user-defined. The user should set the color for each class in the class domain.

- Double-click polygon map Landuse in the Catalog. The Display Options - Polygon Map dialog box is opened.
- Accept the defaults in the Display Options - Polygon Map dialog box by clicking OK. The polygon map is displayed.
- The Layer Management pane shows the Legend of the Landuse map, which is in fact, representation Landuse. Double-click the word Legend in the Layer Management pane. The Representation Class editor is opened in the polygon mode (e.g. the Polygon tab is active).

Each item in the domain has a color assigned to it. The colors can be edited by clicking on an item, and then changing the Red/Green/Blue amount by dragging the slide bars in the Color Slider, by selecting a color in the Color Selector or by double-clicking an item in the editor.

- Practice with changing colors as explained above. Change also some colors by using the Edit Item(s) button or by opening the Edit menu and selecting Edit Item(s).
- Select the Segment tab and look at the representation. After that, select the Point tab. Since we can use the same domain, and the same representation for raster, polygon, segment and point maps, these options can be used to see what a line would look like, or a point, or an area.
- Have a look at the other menu items and try some.
- After that, close representation Landuse.

Identifier domains (ID) do not need a user-defined representation because the IDs are usually just numbers without a certain meaning.
Main concepts of ILWIS 3.0

- In the Catalog, double-click polygon map Cityblock. In the Display Options - Polygon Map dialog box, you see several options: Single Color, or Multiple Color 7, 15 or 31.
- Select the option Multiple Colors, 31 and click OK.

For an identifier map such as the map Cityblock it would be useless to spend much time in defining the color of each individual item by hand, since different colors do not represent any thematic difference. The colors are only used to make a differentiation between the units. Therefore, a user-defined representation is not needed.

Furthermore, you will generally display ID maps by one of the attributes found in the attribute table of the map. For more information see section 7.2.

- Close polygon map Cityblock.

More about representation value

Maps with a value domain have a representation value. You can make two types of representations for value maps:

- a representation value, in which boundaries and intermediate limits appear in values;
- a representation gradual, in which boundaries and intermediate limits appear in percentages. If you use it on a value map, the percentages of the frequency distribution of pixel values are taken from the histogram.

- In the Catalog, click domain Height with the right mouse button, and select the Properties command from the context-sensitive menu. The Properties sheet is opened. As you can see, domain Height has a representation value called Height.
- Close the Properties sheet and open representation Height by double-clicking the object in the Catalog. The Representation Value editor is opened.

A representation for a value domain is defined on the basis of a number of limiting values between which the color changes from one color to another in a number of user-defined steps. In this example the limits are 2500 (the minimum of the domain), 3500, and 4600 (the maximum value of the domain). You can insert as many intermediate limits as you wish.
There are also a number of system-defined representations available. These representations all use percentages as limits (representations of type gradual), so that they can be used on different types of value ranges.

- Select the Limit 3500, open the Edit menu and select the Edit Limit command or click the Edit Limit button in the Toolbar of the Representation Value editor.
- In the Edit Limit dialog box, change the color to LawnGreen and click OK.
- Open the Edit menu and select Stretch Steps. The Stretch Steps dialog box is shown. Change the Stretch Steps value to 30 and click OK.
- Select the word Stretch in the editor. A drop-down list box appears.
- Click once more to open the list box and select the word Upper. This means that all values between the limits are displayed in the color of the upper limit.
- From the Edit menu choose Insert Limit. The Insert Limit dialog box appears.
- Insert a new limit (Value 4000, Color Gold) and click OK in the Insert Limit dialog box.
- When finished close representation Height.

There are also a number of system-defined representations available. These representations all use percentages as limits (representations of type gradual), so that they can be used on different types of value ranges.

- Click the Customize Catalog button in the Standard toolbar of the Main window. The Customize Catalog sheet appears.
- On the Selection tab, select object type Representation in the list box, select the check box Include System Objects and click OK. Now you will see only the representations, including the system-defined ones.
- Open some of these representations to see how the colors are assigned to different percentage values.
- Click again on the Customize Catalog button. Select all the objects from the list, clear the check box Include System Objects and click OK.
- In the Catalog, double-click the segment map Contour. The Display Options – Segment Map dialog box is opened.
- Select a system-defined representation, for example Representation Red and click OK. Now the contour lines are displayed according to that representation.
- Double-click the word Legend in the Layer Management pane. The Representation Gradual editor is opened. It is not possible to edit this representation because it is a system-defined one and system-defined representations cannot be edited.
- Close the Representation Gradual editor.
- After finishing, close the map Contour.
Summary: About representations

- A representation contains information that determines how your spatial data should be represented on screen or in a printout. Representations are service objects linked to a domain. The domain determines what is in a map (or a table or a column), and the representation defines which colors these domain items should have.

- There are different types of representations, depending on the type of domain.

- Class domains always have a user-defined representation Class.

- ID domains cannot have a user-defined representation. They can only be displayed in 1, 7, 15 or 31 different colors or by one of their attributes (see section 7.2).

- Value domains can have two types of representations:
  - representation Value, using actual values as limits;
  - representation Gradual, using percentage values as limits.

See also chapter 13 if you want to know more about representations.
2.5 About coordinate systems

In section 1.3, you already learnt that the Status bar in a map window displays the coordinates of a map.

- Open polygon map Landuse by double-clicking it in the Catalog. The Display Options - Polygon Map dialog box appears.
- Accept all defaults in this dialog box and click OK. Polygon map Landuse is displayed.
- Maximize the map window.
- Move the mouse pointer through the map and verify the display of coordinates in X and Y values, as well as in degrees, minutes and seconds in the Status bar.
- Close polygon map Landuse.

The information on the X and Y coordinates of a vector map is stored in a service object called the coordinate system. A coordinate system is a service object for point, segment and polygon maps, and for georeferences (the latter are used for raster maps and will be treated in the next section). A coordinate system contains information on the kind of coordinates you are using in your maps. You may for instance use user-defined coordinates, coordinates defined by a national standard or coordinates of a certain UTM zone.

- Click the Customize Catalog button in the Standard toolbar of the Main window. The Customize Catalog dialog box is opened.
- In the Customize Catalog dialog box, select object type Coordinate System, select the check box Include System Objects and click OK.

The Catalog now only shows coordinate systems. One coordinate system was made especially for the data set: Cochabamba. The other three (Latlon, LatlonWGS84 and Unknown) are standard ones.

- Open coordinate system Cochabamba by double-clicking it in the Catalog. A dialog box is opened titled Coordinate System Projection “Cochabamba”.

A coordinate system defines the possible minimum and maximum X’s and Y’s that can be used in a map, and in case of a coordinate system of type projection, you can also store information on a map’s projection, ellipsoid and/or datum. Normally locations on the earth’s surface are shown in geographic coordinates.
The **Geographic Coordinates** of the earth are expressed in Latitudes and Longitudes (see Figure 2.2). **Latitudes** (parallels) are measured from the equator and may range from 0° to 90° N or from 0° to 90° S. **Longitudes** (meridians) are measured from the Greenwich meridian and may range from 0° to 180° E or from 0° to 180° W.

![Geographic coordinate system](image)

**Figure 2.2:** Geographic coordinate system: the location of A is determined by the Longitude (\(\lambda\)) and the Latitude (\(\phi\)).

The shape of the earth is like a ball (spherical) or like a “horizontal rugby ball with flattened poles” (ellipsoidal). To represent areas from this sphere or ellipsoid into a plain surface, you need a **map projection**. The earth’s surface can even be better approached if a projection uses a datum. With the help of a map projection, geographic coordinates are converted into a metric coordinate system, measuring the X and Y directions in meters. Practically every country in the world uses its own coordinate system, based on a certain projection. One of the most used projections is the so-called **Universal Transverse Mercator (UTM)**.

The UTM is an international metric coordinate system, which covers the whole earth and divides it into 60 zones each covering 6° Longitude. Because of the small area covered by each zone, a high degree of accuracy is possible.

In **ILWIS** you can digitize a map either in metric or in geographic coordinates. The conversion from geographic to metric coordinate is done via a map projection. For example, point data obtained from GPS (Global Positioning Systems) may have been registered in geographic coordinates.

**ILWIS** has three standard coordinate systems:
- **Latlon**: Geographical coordinates in degrees.
- **LatlonWGS84**: Geographical coordinate system using the WGS84 datum.
- **Unknown**: When coordinates are not known. This coordinate system should not be used.

For more information on types of coordinate systems and transformations, see section 4.2. In general it’s best to create a coordinate of type projection and specify the minimum and maximum X and Y coordinates of your study area. Projection information may be added to the coordinate system in a later stage or not at all.
In principle, all maps of the same area should have the same coordinate system. ILWIS assumes that all maps that you want to superimpose or display together in one map window have the same coordinate system. Displaying maps with different coordinate systems is possible if projection information is available for both coordinate systems. Then the coordinates of a vector map are transformed on the fly according to the coordinate system that the map window is using at the moment. Of course, you can use the Transform operations to permanently transform coordinates (see chapter 4 for more information).

- Note that the Projection in the coordinate system Cochabamba is UTM, with the Ellipsoid International 1924 and that the Datum is Provisional South America 1956, with the Datum Area Bolivia.
- Click Cancel in the Coordinate System Projection dialog box.
- Click the Customize Catalog button in the Standard toolbar of the Main window and select all objects. Clear the check box Include System Objects and click OK.

The use of projections is further discussed in chapter 4.

**Summary: About coordinate systems**

- A coordinate system is a service object for point, segment and polygon maps, and for georeferences (the latter are used by raster maps and will be treated in the next section). Vector maps and georeferences always need a coordinate system.

- A coordinate system defines the possible XY-coordinates or LatLon-coordinates that can be used in your maps and thus stores information on the kind of coordinates you are using in your maps. You may for instance use user-defined coordinates, coordinates defined by a national standard or coordinates of a certain UTM zone.

- A coordinate system may have information on the map’s projection, ellipsoid and datum.
2.6 More about georeferences

A georeference is a service object, which stores the relation between the rows and columns in raster map(s) and the ground-coordinates (X, Y). A georeference is needed for raster maps and uses a coordinate system. If you work with several raster maps of the same area, and you want to overlay them (e.g. with the Cross operation), it is important that all maps have the same number of rows and columns, and the same pixel size. The pixels in both maps thus refer to the same position on the ground. Therefore all raster maps of the same area should have the same georeference. Let us look at a georeference.

- Open georeference Cochabamba.

Georeference Cochabamba is a georeference corners. By defining the X and Y values of the corner of the raster map, ILWIS is able to find the correct coordinates for each pixel. A georeference corners assumes that the raster map is oriented to the north. The X-coordinate increases from the left column to the right column, and the Y-coordinate increases from the lowest line to the upper line. The X and Y values relate to the coordinate system that we have seen in the previous exercise.

A georeference corners has information on the number of rows and columns in the map, the coordinate system, the minimum and maximum X- and Y-coordinates of the corners of the map, and the pixel size.

A georeference of type corners is used for instance for maps which are converted from vector to raster (i.e. rasterized vector maps).

- Check if the pixel size given in the GeoReference Corners editor is correct; subtract the minimum X value from the maximum X value. Then divide the resulting value by the number of columns.

For such calculations you can also use the Command line of the Main window.

- Position the mouse pointer on the Command line and type an expression such as:
  $\frac{\text{max X} - \text{min X}}{\text{nr. columns}}$
- Close georeference Cochabamba after you have seen the result of the expression in the Calculation Result box.

For satellite images, scanned aerial photographs and other imported images, which may not be north-oriented, we have another type of georeference: a georeference tiepoints.
In the satellite image you will see seven points displayed, which are related to the seven points in the Tie Point Table of the GeoReference Tiepoints editor. For each point the X- and Y-coordinates are given, along with the Row and Column locations of these points in the image. On the basis of these coordinates using an Affine transformation, all rows and columns will be assigned X- and Y-coordinates, with a certain error, expressed as Sigma. In Chapter 6 we will treat the GeoReference Tiepoints editor in much more detail.

What is important to note here is that the image is not oriented perfectly to the north. The image is distorted with respect to a topographic map. When you want to overlay images in combination with north oriented maps, you need to remove the distortion of the image by resampling it (see chapter 6).

The grid lines are displayed in a rotated way. From this you can conclude that the image is distorted and not oriented to the north.

- Drag and drop raster map Landuse in the map window. Raster map Tmb1 will be replaced by raster map Landuse. You will see that the display of grid lines and the contour lines now changes. They are now displayed in a north-oriented way.
- Close the map window.
Summary: About georeferences

- A georeference is needed for raster maps and uses a coordinate system.

- A georeference is a service object, which stores the relation between the rows and columns in raster map(s) and the ground-coordinates (X, Y).

- Two types of georeferences for raster maps were discussed here:
  - **Georeference corners**, used for raster maps made from rasterizing vector maps, and the resulting maps from operations on these maps. A georeference corners is used for raster maps that are oriented to the north.
  - **Georeference tiepoints**, used for satellite images, scanned aerial photographs and other imported images, which may not be north-oriented.

- In the chapters 6 and 10 you will see that there are several other types of georeferences.
2.7 Attribute data

In sections 2.1 and 2.2 we have looked at the way maps are stored and displayed in ILWIS, either as point, segment, polygon or raster maps. In the sections 2.4 up to and including 2.6 we have also looked at the service objects that contain information about these maps, such as a domain, a representation, a coordinate system and a georeference.

In section 1.3 we have also seen that spatial data (maps) can be linked to non-spatial, or attribute data (tables). In order to be able to link a map with a table, the units of a map must be linked to records in a table. The attribute information can then be added in columns. In other words, a map and its attribute table should use the same domain. Let us briefly check this again.

- In the Catalog, select domain Landuse, table Landuse and polygon map Landuse (hold the Ctrl-key down while selecting the objects).
- Click the right mouse button and select Open from the context-sensitive menu. All three objects are opened.
- Move the three windows in such a way that you can see all three next to each other. Resize the windows if necessary.
- Click several units in the polygon map. Note that the class names appear in the map, in the table and in the domain.
- When finished activate the Main window, open the Window menu and select Data Windows, Close All. All three windows will be closed.
- In the Catalog, select table Landuse, click it with the right mouse button and select Properties. The Properties of Table “Landuse” sheet is opened. Note that the domain of the table is Domain Class “Landuse”. Click the Cancel button.
- Click with the right mouse button on polygon map Landuse, and select Properties. The Properties of Polygon Map “Landuse” sheet appears. Note that this map also uses the Landuse domain. Close the Properties sheet by clicking Cancel.

So we can conclude that maps and tables can be linked if they have the same domain. However, there is a very important restriction that should be mentioned here. It is only possible to have an attribute table with a class domain, or with an ID domain. Tables with a value domain are not possible. The reason for that is:

- Suppose you have defined a value domain with minimum 0 and maximum 10000, and a precision of 0.01. In that case, a table connected to the map should have a very large number of records (10000*100 = 1,000,000). The number of records and the extreme size of a table will become a problem.
- A more important reason, however, is that value maps themselves do not contain information to which attributes they can be linked. They are in fact attribute maps, and not thematic maps. The Landuse map (with a class domain) can have an
attribute table, in which for each land use type information is given, such as the biomes production per hectare, the value of the land per hectare, etc.
- The Cityblock map (with domain ID) can have an attribute table in which information is stored for each city block, such as the number of people living in the block, the number of houses, public buildings, shops, etc.
- A value map, on the other hand, such as the segment map Contour, contains values, representing a certain phenomenon (in this case terrain elevation). It is difficult to imagine which attributes could be linked with such information, other than purely statistic information (e.g. the length of each line).

The linking of maps with attribute tables is useful if you want to substitute the units of a map with an attribute value from the connected table (a process called renumbering). In that case you generate an attribute map.

Although value maps cannot be linked to attribute tables, you can generate tables from value maps. The most important ones are cross tables and histograms. These are not used, however, to renumber the value maps. It would make no sense to replace the DN values (reflectance values) of a satellite image with the area attribute from its histogram.

Summary: Attribute data

- Maps and tables can be linked only if they have the same domain.

- Only maps with a class or ID domain can be linked to attribute tables. Value maps cannot be linked to tables.
2.8 Pixel Information window

ILWIS has a special tool with which you can examine multiple maps and linked tables simultaneously: the pixel information window. A pixel information window is used to interactively inspect coordinates, class names, IDs or pixel values, in one or more maps and attribute values of map-related tables. A pixel information window shows information at the position of the mouse pointer in a map window.

- Open polygon map Landuse.
- In the map window, open the File menu and select Open Pixel Information. The pixel information window (Figure 2.3) is opened.
- Position both windows next to each other and move the mouse pointer over the map.

A pixel information window consists of many items that you have seen before in map and table windows, such as a Control-menu icon, Title bar, Menu bar, Status bar, etc. Some special items in this window are:

- **Top left button**: the upper left gray button in the pixel information window can be used to open the Customize Pixel Info dialog box.

- **Information viewer**: where the information of the selected data objects for the actual position of the mouse pointer in a map window is displayed.

- **Menu bar**: the menus of the ILWIS pixel information window are: File, Edit, Options and Help.

![Figure 2.3: An ILWIS Pixel Information window.](image)
If you want to display information on maps and tables in the pixel information window, you must make sure that at least one map is displayed in a map window, and that the maps are linked to their attribute tables.

We will now add map **Geomorphology** to the pixel information window to read the information from this map, along with that of the **Landuse** map.

It is possible to hide or to show maps and attributes in a pixel information window:

- Drag and drop the polygon map **Geomorphology** from the Catalog to the pixel information window.
- Position the mouse pointer in the map window.
- In the pixel information window, you can read the information of the mapping unit in map **Geomorphology**, and of the mapping unit in map **Landuse** at the same location.
- Move the mouse pointer over the map to display the information continuously.

The **Customize Pixel Info** dialog box shows a list of maps, tables and columns that are presently visible in the pixel information window. The list box **Show values of** can be used to select the maps, tables or columns you would like to see. You can select or deselect them by clicking on them. Selected items appear highlighted. With the check boxes you can define if the information is displayed when working with a **Mouse** pointer or with a **Digitizer** cursor, and whether the information should be displayed continuously (while moving over the map), or only when you click a unit.

- Deselect all columns of table **Geomorphology** and click OK.
- When you now move with the mouse pointer over the map you will see that no information is given on the table **Geomorphology**.
- Close the pixel information window by double-clicking the **Control menu icon**.
- Close the map window.
Summary: Pixel Information window

- A pixel information window is used to interactively inspect coordinates, class names, IDs or pixel values in one or more maps and attribute values of map-related tables.

- A pixel information window shows information at the position of the mouse pointer in a map window.
2.9 Details view of a Catalog

You can choose to see the objects in a Catalog listed in List View or in Details View. The List View option gives a simple list of object names and icons. The Details View shows detailed information for each object.

- In the Main window open the View menu and select Details or click the Details button in the Standard toolbar. The Catalog, which is currently active, changes from a List View into a Details View.

The Details View is a table with columns that give you extra information on individual objects such as: dependent or not, used domain/georeference/coordinate system, description, expression, etc. To change the order of the columns in the Catalog:

- Drag and drop a column header horizontally to another position.

To change the width of a column in the Catalog:

- Drag the vertical line which separates two column headers to the left or right.

The Catalog is by default ordered ascendingly by Name but you can order the objects descendingly or use another sorting method (e.g. by Type, Size, Attribute, etc.).

- Click column header Name. The objects will now be sorted descendingly. Click the column header Name once more. The objects are sorted ascendingly again.
- Click the right mouse button in the white space of the Catalog, choose the Sort By command from the context-sensitive menu, and select sorting method Type. The Catalog is now ordered by object type (i.e. coordinate system, domain, georeference, etc.).
- Open the View menu in the Main window, select Sort By and the sorting method Object Size.

Sorting ascendingly and descendingly can be used on any column. You can also sort objects when in List View. To return to the original situation:

- Open the View menu in the Main window, select Sort By and sorting method Name or click the column header Name in the Catalog.

By using a Catalog query, ILWIS will scan the contents of all object definition files in the current Catalog and show only those objects that are the result of the query.
By using a query, you can search for instance for objects that use domain type class/ID, domain type image, a certain domain (e.g. domain `Landuse`), a certain georeference, etc.

**Open the View menu in the Main window, select Catalog Queries and the predefined query Maps with georef tiepoints.**

In this Catalog, raster map `Tmb1` is the only map that uses a georeference tiepoints. The query that is in use is shown in the Status bar of the Main window. Besides using predefined queries it is also possible to construct your own queries.

**Click the Customize Catalog button in the Standard toolbar of the Main window. The Customize Catalog sheet is opened.**

**Select the Query tab and click the Help button to get information about defining your own queries.**

**You will create a query. Type in the Query text box:**

```
map.domain = Landuse
```

and click OK on the Query tab. The query shows all the raster, polygon, segment and point maps that use domain `Landuse`. In this exercise, raster map `Landuse` and polygon map `Landuse` use the domain `Landuse`.

**To turn off the query, type Dir on the Command line, or open the View menu, and select the Catalog Queries, All command.**

**Summary: Details view of a Catalog**

- In ILWIS you can see objects in a Catalog in List View or in Details View.

- The Details View is a table with columns that give you extra information on individual objects.

- In each Catalog, you can specify the visible object types, the sorting method of objects, and a query to search for specific objects.

- You can use predefined queries but you can also construct your own queries.
2.10 Object properties and dependency links

As shown in preceding sections, different data objects (point, segment, polygon and raster maps) and service objects (domains, representations, coordinate systems and georeferences) are required to form a map in ILWIS. How does ILWIS know which objects are linked?

The properties of an object show which service objects are used for a data object or another service object. In section 2.2 you saw that for the display of vector maps, you need to have a coordinate system, a domain and a representation (depending on the domain) and that a raster map requires the same objects, plus the georeference. In section 2.7 it was shown that class and ID maps could also be linked to attribute tables.

In Figures 2.4 and 2.5, a schematic representation is shown of the properties of vector and raster maps. The properties of vector maps with a class domain, identifier and value domain are shown in Figure 2.4.

The objects indicated in the shaded boxes are the data objects (i.e. point, segment, polygon maps and tables) and the objects outside of these boxes are the service objects. The arrows indicate the relations between the objects. For example, in Figure 2.4, a domain is used by a vector map (either a point, segment, or polygon map), by a table, and by a representation.

All the properties of an object can be viewed from their Properties sheet.

- Click in the Catalog with the right mouse button on class domain Landuse, and select Properties from the context-sensitive menu. The Properties sheet is opened.
- Click the Used By tab.

A list of objects is shown which use this domain Landuse: raster map Landuse, polygon map Landuse, table Landuse, and representation Landuse.

- Close the Properties sheet.

To understand the Figures 2.4 and 2.5 it is good to look at the properties of several maps.

- In the Catalog click with the right mouse button on domain Cityblock and select Properties from the context-sensitive menu. The Properties sheet appears.
- Click the Used By tab. Cityblock is an ID domain, used by polygon map Cityblock, and table Cityblock.
Figure 2.4: The properties of vector maps with a Class, Identifier and Value domain in ILWIS. The data objects are shown in a shaded box.
The properties of tables and columns are schematically represented in Figure 2.6. A table should have a class or ID domain. A table contains a number of columns. Each column also has a domain (e.g. class, ID, value or other special domains such as color, string, Bool, etc.).

Figure 2.5: The properties of raster maps with a Class, Identifier, and Value domain in ILWIS. The data objects are shown in a shaded box.

- Compare the result with Figure 2.4 and close the Properties sheet afterwards.
- Repeat this for value domain Height. This domain is used by segment map Contour and by representation Height. Compare with Figure 2.4.

The properties of tables and columns are schematically represented in Figure 2.6. A table should have a class or ID domain. A table contains a number of columns. Each column also has a domain (e.g. class, ID, value or other special domains such as color, string, Bool, etc.).
The relationships between a data or service object and several service objects are called the properties of the object.

When maps are used to create other maps, for instance by performing an operation or executing an expression, then this operation or expression and the input map name(s) are stored inside the new map. This is what ILWIS calls dependency.

**Dependencies**

The relationships between a data or service object and several service objects are called the properties of the object.
Output maps thus know how they are created and on which input maps, tables or columns they depend. Such output maps are called *dependent data objects*. The same applies for tables and columns. The operation or expression stored inside the dependent data object is called the *definition*.

Let us look at an example. Polygon map *Landuse* was used in combination with the georeference *Cochabamba* to generate a raster map *Landuse*. This is shown schematically in Figure 2.7.

The dependent raster map, which is the result of the Polygon to Raster operation (i.e. the Rasterize Polygon Map operation), contains information on the source objects from which it was created. In this case a polygon map and a georeference. Let us check this example in the data set.

- Click in the Catalog with the right mouse button on raster map *Landuse* and select Properties from the context-sensitive menu. The Properties sheet with the title Properties of Dependent Raster Map “Landuse” is opened (see Figure 2.8).
The Raster Map tab gives you information on the service objects of this map and information on how the map was made (i.e. the Definition): 

MapRasterizePolygon(Landuse.mpa, Cochabamba.grf)

Where:
MapRasterizePolygon is the Polygon to Raster operation;
Landuse.mpa is the polygon map Landuse used to generate this map, and
Cochabamba.grf is the georeference Cochabamba used to generate this map.

Why does ILWIS keep track of the objects that are used to generate another one? When you update input source maps, tables or columns by editing, the dependent output maps, tables or columns which use these source objects can be easily recalculated.
This means that none of the source objects (i.e. polygon map Landuse and georeference Cochabamba) have been updated since the dependent raster map was generated. You can verify this by examining the Catalog.

Now we are going to update the source map Landuse.

The polygon map is updated now. In the Catalog of the Main window you can see that all the maps are modified on the same date and time and that raster map Landuse is Dependent (D), Calculated (C) and Up-to-Date (U).

It is important to keep in mind that dependent maps are not automatically updated. ILWIS does keep track of the dates and times at which the source objects were modified. Only when you click the button Make Up-to-Date on the Dependency tab of the Properties sheet, ILWIS will ask you if you want to recalculate the map.

Click the Make Up-to-Date button. A Check Up-to-date message appears with the question Dependent raster map “Landuse” is not up-to-date. Recalculate it to make it up-to-date?

Answer Yes to this question to recalculate the map.

Open the Properties sheet of raster map Landuse. On the Dependency tab you see that the Object is up-to-date again.
In the Preferences of the Main window, you can select the check box Give a Warning when an object is not up-to-date. If you select this check box ILWIS gives you a warning when you want to open an object that is not up-to-date anymore.

There are some other important advantages of the use of dependencies:

- For maps, tables or columns that are created via the MapCalc and TabCalc expressions, you can change the definition of the dependent output data objects; so you can do a similar calculation again with different parameters without having to create a new map, table, or column.

- You can release disk space: it is possible to delete the files that contain the actual data values (e.g. .MP# and TB# files), as long as the object definition files (e.g. .MPR, .MPA, .MPS, .MPP or .TBT files) which contain the definition to recalculate the dependent data objects remain.

Now the actual data file of the raster map is deleted. Only the definition of the map remains, so the map can always be recalculated. In the Catalog of the Main window you see that the raster map Landuse is now Dependent (D), Not Calculated (N) and Not Up-to-Date (N). We will recalculate the data file of the raster map below.

In this example the raster map had 932 lines and 637 columns. Each pixel was stored as 1 byte. So you save $932 \times 637 = 593684$ bytes of disk space, without losing any actual information.

You will see that the contents of the sheet have changed. On the General tab, note the size of the object: 814 bytes. This amount of storage space is needed for the information of the object definition file. On the Dependency tab, you now find a button Calculate. By pressing this button you can recalculate the map using the expression which is available in the object definition file of raster map Landuse.

A so-called tranquilizer is displayed, showing the progress of the calculation of the map. When it stops, the raster map Landuse is again Dependent (D), Calculated
(C) and Up-to-Date (U) and the data file of the raster map is available.

- Open the Properties sheet of raster map Landuse.

Now the dialog box looks like it was in the beginning. Note the object size is almost 600000 bytes.

It is also possible to convert a map (or a table, or a column) from being a dependent object to a source object. In that case you will break the dependency link. After that, the map cannot be updated anymore from the Properties sheet. You actually need to do the operation again.

- On the Dependency tab, click the button Break Dependency Link. A Break Dependency Link message appears.
- Confirm the question with Yes. The Properties sheet is closed.
- Open the Properties sheet again and note the difference.

The Properties sheet will not contain information on the dependency links anymore (i.e. the Dependency tab is not available anymore in the Properties sheet).

In chapter 7, the link between maps and tables is explored further and in chapter 8 you will practice some more with dependencies.

**Summary: Object properties and dependency links**

- The relation between a data object and service objects, or between service objects among themselves, is specified by the properties of the object.

- The properties are different for vector maps, raster maps or tables. The properties depend largely on the type of domain which is used.

- The link between output data objects, obtained from other input data objects through an ILWIS operation is defined by dependency links.

- Maps, tables and columns are originally when they are digitized, imported or created by typing. These objects are called source objects.

- Output maps, tables and columns which are created through a calculation or an operation are called dependent objects.

- The concept of dependency has a number of important advantages:

  *Easy update:* when you have new information and you edited input maps, tables or columns accordingly, the dependent output maps, tables or columns can be
recalculated as the system can execute their definition again. There is thus no
need to repeat operations and choose input and specify output objects again: you
can simply press the Make Up-to-Date button in the Properties sheet of the
dependent output maps, tables or columns.

*Easy change of calculation formulas:* MapCalc and TabCalc formulas are stored
as the definition of dependent raster maps and columns and can be modified in
the Properties sheet of such a map or column. This enables you to quickly
change calculation formulas and see results displayed in the same raster map or
column. The need to create new maps and columns for similar calculations is
thus reduced.

*Minimum use of disk space:* when you perform a calculation or another opera-
tion and the outcome is a dependent map or table, in principle only the object
definition file of the dependent map (.MPR, .MPA, .MPS, .MPP) or table
(.TBT) is stored on disk. Object definition files are small ASCII files and they
store amongst others the expression by which the output object is created and
contain a reference to the output data file(s). You can directly continue to per-
form calculations and/or operations on the dependent objects that do not have
calculated data files yet.

- When an object is Dependent (D), Calculated (C) and Up-to-Date (U) it means that
  none of the source objects have been updated since the dependent object was gen-
erated.

- When an object is Dependent (D), Calculated (C) and Not Up-to-Date (N) it means
  that (one of) the source objects has been updated since the dependent object was
  generated. You can make the dependent object up-to-date again by using the Make
  Up-to-Date button in the object’s Properties sheet.

- When an object is dependent (D), Not Calculated (N) and Not Up-to-Date (N) it
  means that only the object definition file of the dependent object is stored on disk
  and that the actual data file is deleted. You can recalculate the dependent object by
  using the Calculate button in the object’s Properties sheet.

- It is also possible to convert an object from being a dependent object to a source
  object. You can break a dependency link by using the Break Dependency Link
  button in the object’s Properties sheet.
2.11 How to use geographic data in ILWIS

After you have looked quite extensively at the way geographical data is stored in a Geographic Information System like ILWIS, it is important to ask yourself now what you will do with it. In general, there are four different phases that you have to go through when you work with geographic data:

Data input

You need to ensure that your spatial and non-spatial data is available in digital form in your computer. How you do this depends largely on the data type. For instance, you can digitize maps and you can type tabular data. ILWIS can convert data files derived from scanning, or you can import other digital formats as inputs. Through image processing, ILWIS enables data input from remotely sensed images. The aspects of spatial data input will be dealt with in the next chapter (chapter 3).

Data management

Data can be stored in and retrieved with ILWIS. The data management in ILWIS emphasizes efficiency of storage and retrieval. File formats used are convertible so different data types can be combined. Many aspects of data management in ILWIS will be treated in chapter 4 (on spatial data) and in chapter 5 (on attribute data).

Data analysis

Data analysis is the most important feature of ILWIS, qualifying it as an analytical GIS package. Data analysis is the process in which you generate information that is useful for solving a particular problem. When the data is in the form of satellite images, the data analysis is also called digital image processing. The objective is to generate images that can be interpreted by experts, or to generate classification results, containing thematic information on features such as land use, lithology, etc. The various ILWIS operations on image processing will be covered in chapter 6.

Other data analysis techniques dealing with maps, combined with tables, will be treated in the chapters 7 to 12 which have an increasing degree of complexity.

Data output

The final objective of working with a GIS such as ILWIS is to produce useful output results. Using ILWIS you can show your results on the screen, as hard copy output (printed data) or as soft copy (files to be used further in ILWIS or in other software packages).

All aspects dealing with the generation of output with ILWIS will be treated in the final chapter 13.